Inquiries

The Inquiries panels are used to view the information that has been recorded in NewSouth HR. The updating of data is not possible in most of the Inquiry panels. The ability to view data within NewSouth HR will depend on your security access. Your user ID will tell the system what you have access to.

- Inquiries may be readily accessed using the “Inquiries and Reporting” option in the Business Process Navigator:

- Inquiries may also be accessed through the menus:

Example: Performing a Job Data Inquiry

Follow the steps below to inquire on a Job Summary to view all changes, including salary changes, over the period of employment:

1. Access **Job Summary** panel (Go>Administer Workforce> Administer Workforce (AUS)>Inquire>Job Summary)
2. Enter **ID**, **Name** or **Last Name** and select **OK** or **Search**
3. Use the Scroll bar on the right of the panel to scroll through effective dated changes to data.
Below is a table of the more common Inquiries that are made in NewSouth HR. To view a step-by-step PowerPoint demonstration of how to conduct the Inquiries, refer to the HR Systems web site: [http://www.hr.unsw.edu.au/hrdirsys](http://www.hr.unsw.edu.au/hrdirsys)

### List of Common Inquiries in NewSouth HR

<table>
<thead>
<tr>
<th>Category</th>
<th>Inquiry Name and Menu Path</th>
<th>Information Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERSONAL DATA</td>
<td>Personal Data</td>
<td><strong>Personal Data 1</strong> and <strong>Personal Data 2</strong> panels display information on name, address, telephone, gender, birth-date and highest education level. This information may be updated, however it is not possible to update your own data from these panels.</td>
</tr>
<tr>
<td></td>
<td>Go &gt; Administer Workforce &gt; Administer Workforce (AUS) &gt; Use &gt; Personal Data &gt; Personal Data 1</td>
<td></td>
</tr>
<tr>
<td>PERSONAL DATA</td>
<td>Emergency Contacts</td>
<td>The names and contact details for the employee’s ‘next-of-kin’ may be recorded for use in emergency. Information regarding the contact’s name, relationship to employee, address and telephone details are held. This information is not collected or maintained by the Human Resources Department. Emergency Contacts may be updated, however it is not possible to update your own data from these panels.</td>
</tr>
<tr>
<td></td>
<td>Go &gt; Administer Workforce &gt; Administer Workforce (AUS) &gt; Use &gt; Emergency Contact &gt; Emergency Contact 1</td>
<td></td>
</tr>
<tr>
<td>PERSONAL DATA</td>
<td>Global Search</td>
<td>Used to identify people who have an existing relationship with the University. It accesses the Student and Human Resources parts of the database, and one ID is used for the entire database. The Result panel will display all potential matches to the criteria entered and includes First and Last Name, Birth-date, and Gender.</td>
</tr>
<tr>
<td></td>
<td>Go &gt; Maintain People Data &gt; Inquire &gt; Search Match &gt; Search Match</td>
<td></td>
</tr>
<tr>
<td>JOB DATA</td>
<td>Job Data Summary</td>
<td>Used to view a summary of changes made to an employee’s Job Data over the period of employment. Includes changes to job and position data and includes all salary changes. A separate summary is held for each employment record number. There will be an employment record number for each concurrent job.</td>
</tr>
<tr>
<td></td>
<td>Go &gt; Administer Workforce &gt; Administer Workforce (AUS) &gt; Inquire &gt; Job Summary</td>
<td></td>
</tr>
<tr>
<td><strong>JOB DATA</strong></td>
<td><strong>Leave Shift Data</strong></td>
<td>Used to inquire on the fortnightly hours profile recorded for an employee with a part-time position. This Inquiry will take the user to the Job Data 4 panel. It is possible to have a different profile for each week in the fortnight.</td>
</tr>
<tr>
<td><strong>LEAVE</strong></td>
<td><strong>Leave Application Summary</strong></td>
<td>Used to inquire on all leave applications recorded since commencement of employment or September 1996, whichever is the latter. Lists the Absence Type, the Begin and Return Dates, Duration in hours and Leave Status.</td>
</tr>
<tr>
<td><strong>LEAVE</strong></td>
<td><strong>Leave Plan Balances</strong></td>
<td>Displays Leave Balance by ID and Empl Rcd# by fortnightly Accrual Date. Part-time employees should always refer to the Hours Balance. Full-time employees may also refer to the Days Balance.</td>
</tr>
<tr>
<td><strong>PAYROLL DATA</strong></td>
<td><strong>Paycheque Data</strong></td>
<td>Displays an Employee’s pay details for each active Employment Rcd#. Gives detail on earnings, taxes, and deductions for each pay period.</td>
</tr>
<tr>
<td><strong>PAYROLL DATA</strong></td>
<td><strong>Salary Plan Grade and Step</strong></td>
<td>Displays hourly, monthly and annual salary rates by step for each of the Salary Administration Plans as per future current and historical Effective Dates back to 01/10/94. The rates do not include on-costs. For current on-costs refer to the website: <a href="http://www.hr.unsw.edu.au/oncosts.htm">http://www.hr.unsw.edu.au/oncosts.htm</a></td>
</tr>
<tr>
<td><strong>SUPERANNUATION</strong></td>
<td><strong>Benefits Summary</strong></td>
<td>The Benefits Summary lists all Superannuation plans in which the Employee is enrolled for each Empl Rcd#. Includes the percentage participation, begin and end dates if applicable, and last salary deduction.</td>
</tr>
<tr>
<td><strong>TIME &amp; ATTENDANCE</strong></td>
<td><strong>Timesheet by Employee</strong></td>
<td>Displays details of timesheets submitted by casual or shift Employees for each Empl Rcd#. The inquiry can display all claims held in NewSouth HR or parameters may be entered to make the inquiry more specific.</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Additional Pay</strong></td>
<td><strong>Allowances</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displays details of allowances paid to an employee for each Empl Rcd #. Every allowance has an Earnings code and NewSouth HR keeps a history of payment by effective date.</td>
</tr>
<tr>
<td></td>
<td><strong>FINANCIAL INFORMATION</strong></td>
<td><strong>Paycheque Distribution</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displays details of the funding of the salary; <strong>Paycheck Distribution Deductions</strong> displays details of the funding details of the deductions paid by UNSW; and <strong>Paycheck Distribution On costs</strong> panel displays details of the on-costs for the Employee for each Empl Rcd# on each Pay End Date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Account Code Translation</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This inquiry is used to translate the 9 Digit HR Account Code to the GL ChartField or vice versa. A search can be conducted with all or part of the ChartField. The <strong>HR Account Code</strong> panel allows the user to drill down to look at the account details</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Account Distributions</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The <strong>Accounting Distributions</strong> panel displays a summary of the funding source of salary and allowances by Employment Rcd #.</td>
</tr>
</tbody>
</table>
Reporting

For the majority of users, standard reports will be sufficient for their reporting requirements. A standard report is one that is accessible via the NewSouth HR menus and Business Process Navigators.

Generally you will want to:
1. Generate the Report
2. View the Report on the Web
3. Print or Save the Report

Alternatively, user-specified reports can be generated. These are custom built using one of three reporting tools available in NewSouth HR. These tools are:

- **Query** - designed to run and create database queries without having to perform SQL programming.
- **Crystal** - a versatile report formatter used for many common reporting needs. Crystal reports are run on the PSNT server and viewed via the Web.
- **Structured Query Report (SQR)** - ideal for high volume, transaction, or batch report generation where report layout is static. SQR reports are run on the PSUNX server and viewed via the Web.

Each type of report has a different level of complexity, and requires slightly different skills to build.

Because users must have a thorough understanding of PeopleSoft table structures, and relational databases in order to use these tools, only key users have the ability to generate user-specified reports.

**Note:**
- Any enquiries regarding Reporting in NewSouth HR should be directed to Andrew Lewis (9385) 2721 a.lewis@unsw.edu.au
- Because of the ability to post reports to the web, only a few key users need to know how to generate user-specified reports. If you have any enquiries regarding user-specified reports contact Andrew.
Below is a table of the more common Reports that are run in New South HR. To view a step-by-step PowerPoint demonstration of how to run the Reports, refer to the HR Systems web site: [http://www.hr.unsw.edu.au/hrdirs](http://www.hr.unsw.edu.au/hrdirs)

### List of Common Reports in New South HR

<table>
<thead>
<tr>
<th>Category</th>
<th>Report Name and Menu Path</th>
<th>Information in Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LEAVE</strong></td>
<td><strong>Absence History</strong>&lt;sup&gt;1&lt;/sup&gt; Go &gt; Compensate Employees &gt; Administer Leave (AUS) &gt; Report &gt; Absence History</td>
<td>Absences expressed in hours for current employees listed in employee ID order. Includes employee name; department; employee type; job title; absence type; begin and return dates; and duration.</td>
</tr>
<tr>
<td><strong>LEAVE</strong></td>
<td><strong>Leave Accruals</strong>&lt;sup&gt;2&lt;/sup&gt; Go &gt; Compensate Employees &gt; Administer Leave (AUS) &gt; Report &gt; Leave Accrual</td>
<td>Leave balances expressed in hours for part-time employees and days for full-time employees, listed in alphabetical order for each leave plan. Includes the employee name; ID, employment record number, department; employee type; job title; leave type and totals as at the last payday.</td>
</tr>
<tr>
<td><strong>LEAVE</strong></td>
<td><strong>Leave Taken</strong>&lt;sup&gt;3&lt;/sup&gt; Go &gt; Compensate Employees &gt; Administer Leave (AUS) &gt; Report &gt; Leave Taken</td>
<td>Total sick and recreation leave taken expressed in hours for current employees listed in alphabetical order by leave plan. Includes employee name; department; employee type; job title as at the last payday.</td>
</tr>
<tr>
<td><strong>FINANCIAL INFORMATION</strong></td>
<td><strong>Accounting Distributions</strong> Go &gt; Define Budget/Encumbrance &gt; Report &gt; Accounting Distributions</td>
<td>HR Account code and chart-field for employees; within a given department, listed in alpha order. Includes employee ID; employee record number; name; position number; budget level; percentage split; HR account code; and chart-field.</td>
</tr>
</tbody>
</table>

---

<sup>1</sup> Absence History

<sup>2</sup> Leave Accruals

<sup>3</sup> Leave Taken
<table>
<thead>
<tr>
<th><strong>FINANCIAL INFORMATION</strong></th>
<th><strong>Payroll Analysis Query</strong></th>
<th>Listed as the &quot;Payroll Analysis Simple&quot; query; gathers financial data for departments and faculties. It runs to an excel spreadsheet. Includes: accounting date; employee ID; name; employee record number; employment code; salary plan; grade &amp; step; chart-field; HR account code; current earnings; current oncosts; current super; annual rate; ytd earnings; ytd super; ytd oncosts; current earnings commitment; current oncosts commitment; next year earnings commitment; next year oncosts commitment; next year super commitment; increment date; increment rate; termination date; HR deptID; position number; jobcode; program code; and pay end date.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FINANCIAL INFORMATION</strong></td>
<td><strong>Payroll Analysis Report</strong></td>
<td>Financial information by Chart Field. Includes position number; employee ID; jobcode; salary plan grade and step; employee record number; name; annual rate; annual allowance; current pay earnings; current pay oncosts; YTD earnings; YTD oncosts; encumbrance earnings &amp; oncosts; employee total and next year encumbrance.</td>
</tr>
<tr>
<td><strong>PERSONAL DATA</strong></td>
<td><strong>Mailing Labels</strong></td>
<td>A staff statistical report which produces labels. Information extracted includes employee ID; employee record number; title; name; F/T equivalent; department; jobcode; work address. This report generates three files: i) .spf file - mailing labels format ii) .pdf file - report format iii) .txt - a text file for importing into Word for mail merges or Excel etc.</td>
</tr>
</tbody>
</table>
Queries

What is a query?

Query is a tool used to extract data from the database. Query uses SQL (Structured Query Language) to fetch information from a range of data lists (records) according to defined parameters (criteria). It is a very effective and efficient tool to compile statistics and reports. Knowledge of SQL programming is not necessary to be able to run a public query in NewSouth HR.

The type of information that may be accessed through query is broad but restricted by the security profile of the user.

Accessing a Public Query

After logging on to NewSouth HR open Query (View > Navigator Display > Query) the following screen will open: Note: if the panel does not open with the list on the left-hand-side of the screen, click the screen maximise/minimise button: 

Scroll through the list of queries to locate the relevant query. The list appears in alphabetical order of Name (not Description) and given the number of queries listed it may take some time to find the query that is of interest to you. The left side of the panel may be widened to show a Description. To change the width of the left side of the panel place the cursor on the vertical border, when the cursor changes to 2 parallel vertical lines with arrows facing left and right, left-click your mouse and drag left.
Running a Query

Run the query to the panel by double clicking the occurrence of the relevant query on the list. If the query is run to the Panel the information in the query is sorted by different column headings. To change the order of output by the different headers, move your cursor to the column header and click.

To print the Query output shown in the Panel, right mouse click on the occurrence of the relevant query in the list and select Print from the sub-menu displayed. Note: Print Preview is also an option here.

To create an Excel Spreadsheet from the query right mouse click on the occurrence of the relevant query in the list and select Run to Excel from the sub-menu displayed:

If the query is Run to Excel it and can be saved to the user's local drive and manipulated like any other standard spreadsheet for a more appealing presentation. Save as shown below and change the File Name as required.
**Locating the Relevant Public Query**

There are many public queries available for the user to run subject to security access levels. The list of Public Queries is extensive and includes those written to extract student information so one of the most frustrating aspects of query is locating the **Name** within a very long list. Often the **Description** can be misleading.

Below is a list of popular Human Resources queries with a brief description of the information to expect from the output.

<table>
<thead>
<tr>
<th>Query Name</th>
<th>Description</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP011_SAL_HIST_BY_EMPLOYEE</td>
<td>N/A</td>
<td>Prompts the user for Employee ID and displays the salary history of an employee – similar to the information in Job Summary panel.</td>
</tr>
<tr>
<td>CMP012_SAL_HIST_BY_DEPARTMENT</td>
<td>N/A</td>
<td>Prompts the user for <strong>Department ID</strong> and displays the salary history of all employees within the department - similar to the information in Job Summary panel.</td>
</tr>
<tr>
<td>DEPT_ACCT</td>
<td>Accounting Distribution Query</td>
<td>Prompts user for a Run Control ID (first save the required parameters under the Run Control ID: Go &gt; Define Budget Encumbrance &gt; Report &gt; Accounting Distributions) and displays the accounting distributions for each employee’s salary within the selected <strong>Department</strong> for the given <strong>As Of Date</strong>.</td>
</tr>
<tr>
<td>DEPT.Allowance</td>
<td>Allowances by Dept</td>
<td>Displays all the current Allowances of employees within the User’s Department, details include earnings code, description of allowance, rate of payment, start dates, end dates if applicable.</td>
</tr>
<tr>
<td>DEPT_HIRES</td>
<td>Hires and Rehires by Faculty</td>
<td>Prompts user for <strong>Faculty Code</strong> (Dept ID); <strong>Hire Date After; Hire Date Before</strong> and displays names and details of new hires and rehires within a faculty/dept within the given period.</td>
</tr>
<tr>
<td>DEPT_LEAVE_BAL</td>
<td>RL over 50 days</td>
<td>List employees within user’s Department, their <strong>Recreation Leave Entitlement</strong>, Pro-Rata accrual, Leave Adjusted and Leave Taken, etc. <strong>Tip:</strong> Run to Excel so that you may insert a formula within the Excel spreadsheet to derive the recreation leave total.</td>
</tr>
<tr>
<td>DEPT_SHELL</td>
<td>Dept Report for Execoff</td>
<td>Prompts for <strong>Dept ID</strong> and displays: ID; Employment Record #: Name; Gender; Jobcode; Title; Empl Code; Compensation Rate; Standard hours per week; FTE of all active employees and scholarship holders within the Department.</td>
</tr>
<tr>
<td>DEPT_TERMS</td>
<td>Reports on Faculty Termination</td>
<td>Prompts user for <strong>Faculty Code</strong> (Dept ID); <strong>Term Date Greater Than; Term Date Less Than</strong> and displays names and details of employment terminations within the given period.</td>
</tr>
<tr>
<td>NSHR017</td>
<td>Hours Claimed by Casual General</td>
<td>Prompts for <strong>Timesheet From Date</strong> and <strong>Timesheet To Date</strong> and displays the total hours claimed by casual...</td>
</tr>
<tr>
<td><strong>Staff</strong></td>
<td>general staff within the users department for dates specified.</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>

| **PAYROLL_ANALYSIS_SIMPLE** | **Simple Vers. Payroll Analysis** | Prompts user for a Run Control ID (first save the required parameters under the Run Control ID: Go > Compensate Employees > Administer GL Interface > Report > Payroll Analysis). Displays financial data for Department and Pay End date as defined. Includes: accounting date; employee ID; name; employee record number; employment code; salary plan; grade & step; chart-field; HR account code; current earnings; current oncosts; current super; annual rate; ytd earnings; ytd super; ytd oncosts; current earnings commitment; current oncosts commitment; next year earnings commitment; next year oncosts commitment; next year super commitment; increment date; increment rate; termination date; HR DeptID; position number; jobcode; program code; and pay end date. |

| **NSHR015** | **List of DEPTIDS** | Prompts for DEPTID. Enter CENTRAL to return whole tree. |

| **DEPT_HIRES_ACADEMICS** | **ACHIRES and rehires by Faculty** | Prompts for DeptID and Hire Date After and Hire Date Before. Includes ID, Employment Record #, Prefix, Name, Gender, Action, Date Dept, Job Title, Empl code, Sal Plan, Grade and Step. |
Updating Personal Data

Users with Inquiry access to NewSouth HR have the ability to update Personal Data 1 and Personal Data 2, however it is NOT possible for Users to update their own data. Update your own data on the web using Employee Self Service: https://www.staff.online.unsw.edu.au/staff/. To update data of those in your Department:

Navigate to Inquiries / Personal Data / Personal Data using the Business Process Navigator or the menu path: Go>Administer Workforce>Administer Workforce Aus>User> Personal Data> Personal Data 1

Update the relevant fields:
- **Name** (Use the PeopleSoft standard name format; [last name] comma [first name] space [middle names])
- **Prefix**
- **Address 1**
- **Address 2** if required
- **Address 3** if required
- **City** Suburb in CAPITALS
- **State**
- **Postcode**
- **Country**
- **Phone** (home phone)
- **Edit Mailing Address** (used to enter another address, eg a PO box)
- **Other Phone Numbers**

Note: Additional phone numbers can be entered by inserting new rows (F7) or click .
Updating Emergency Contacts

NewSouth HR is able to record the employee’s “next of kin” to be contacted in case of emergency. The Human Resources Department does not collect or enter the data and it is decision for the administration of the individual Departments as to whether the data is kept on NewSouth HR.

Users with Inquiry access to NewSouth HR have the ability to update Emergency Contacts 1 and Emergency Contacts 2. However it is NOT possible for Users to update their own data. Update your own data on the web using Employee Self Service: https://www.staff.online.unsw.edu.au/staff/ To update data of those in your Department:

Navigate to Inquiries / Personal Data / Emergency Contact using the Business Process Navigator or the menu path: Go>Administer Workforce>Administer Workforce Aus>User> Emergency Contact> Emergency Contact 1

Update the relevant fields:
- Contact Name
- Relationship to Employee
- Primary Contact only 1 person may be nominated as Primary
- Same Add/Home as EE If box is checked address details flow from employee’s personal data
- Address 1
- Address 2 if required
- Address 3 if required
- City Suburb in CAPITALS
- State
- Postcode
- Country
- Phone Home phone

Note: Additional contact people can be entered by inserting new rows (F7) or click Other Phone Numbers

Emergency Contact 2 Other Phone Numbers
- Type select values from list
- Phone

Note: Additional contact numbers can be entered by inserting new rows (F7) or click on the inner scroll bar
myUNSW is the single online access point for UNSW services and information, integrating online services for applicants, commencing & current students and UNSW staff. myUNSW can be accessed from any computer on the Internet, anywhere in the world.

myUNSW delivers the following self-service functions for staff:

- Review and update personal details;
- Review and update emergency contact details;
- View and print pay advice;
- View leave balances for recreation, sick and long service leave;
- Forecast leave balances to a future date;
- Review leave history;
- View and update EEO statistical and highest qualifications information;
- Ability to access through myUNSW resources for staff involved in student and academic administration;
- My News & Events and My Announcements, which allows the University to communicate with staff regarding employment and student administration matters at UNSW.

How do I log in?

A valid UniPass and UNSW Student or Employee ID is all that is required to access myUNSW. UniPass is the Universal Password for online services at UNSW. In conjunction with a UNSW Student or Employee ID, it provides a way of electronically verifying your identity.

The Home Tab provides staff with general and personalised news items and announcements and key UNSW information including links to training information and general UNSW services.
**My Staff Profile**

The **My Staff Profile** tab allows staff to access the self-service functions of the central HR record. In addition, this page contains a number of links to key UNSW and external websites.

---

**Recent Pay Advice**

This is a summary of the last five pay advice statements, displayed in descending date order. To see more detail on a particular pay advice or to view a different date range, click on the 'More' button at the bottom of this list. (This feature can also be accessed from the 'Pay Advice' link in **My Staff Services** channel.)

**Leave Balance**

This is a summary of the current leave accruals. To see further details about leave, click on the 'Details' button at the bottom of this list. (This feature can also be accessed from the 'Leave' link in **My Staff Services** channel.)

---

**How do I navigate in myUNSW?**

Navigate in myUNSW using the home key. Avoid using the 'Back' button on the browser.

---

**:: My Staff Information**

**Recent Pay Advice**

This is a summary of the last five pay advice statements, displayed in descending date order. To see more detail on a particular pay advice or to view a different date range, click on the 'More' button at the bottom of this list. (This feature can also be accessed from the 'Pay Advice' link in **My Staff Services** channel.)

**Leave Balance**

This is a summary of the current leave accruals. To see further details about leave, click on the 'Details' button at the bottom of this list. (This feature can also be accessed from the 'Leave' link in **My Staff Services** channel.)

---

**:: My Staff Services**

**Pay Advice**

The first Pay Advice screen is a summary of the last 10 pay periods, with the option to view the details of an individual pay period or to search by a different date range.

The University encourages all staff with access to the Internet to select the option not to receive pay advice statements in the mail. Select the 'Suppress Mail Delivered Pay Advice' button that is shown at the top of each detailed pay advice screen and answer 'No' to the question "Do you require a mail delivered Pay Advice?"

**Please note:** set this option for every employment record at UNSW.
Leave

Leave is a view of the current entitlement for Sick, Recreation and Long Service Leave (balances for Long Service Leave are only displayed after completion of 10 years service). Leave balances are expressed in days for full-time employees and in hours for part-time employees. Leave balances are displayed for each Employment Record Number. A summary displays all approved leave transactions recorded in NewSouth HR and Leave Forecast allows a calculation of future leave accruals.

Address

Displays all of the addresses recorded on the central HR record. The University requires that home and mailing address is valid at all times. Please check that the address details displayed are correct. You are reminded to inform your Superannuation fund of a change of address.

Phone

Displays all of the contact numbers recorded on the central HR record. Home, work, mobile pager and fax numbers may be recorded.

:: Email

Additional email addresses may be entered however the University will communicate with you using your "campus" email address only e.g. s1234567@unsw.edu.au

Please Note: You cannot edit or delete your "campus" email address.

Emergency Contact

The University requests that all staff keep the contact details of at least one person on their personal record in case of emergencies.

Your Profile

The 'Your Profile' form is used to collect statistical information about staff of UNSW for reporting to the New South Wales Director of Equal Opportunity in Public Employment and the Department of Education Science and Training. Please keep this information current.
**Entering Casual General Staff Timesheets Online**

University casual staff are paid on an hourly basis and submit timesheets each fortnight to the Salaries Unit within the Human Resources Department. The Salaries staff enter details into NewSouth HR to generate salary payments. Responsibility for the collection and checking of the timesheets is generally given to one member of the administrative staff within a work unit, who also delivers them to the Human Resources Department within a strict time schedule (check the time schedule for each fortnight on website: [http://www.hr.unsw.edu.au/salsched.htm](http://www.hr.unsw.edu.au/salsched.htm)). Administrative staff may find it simpler to enter the details of the timesheets on NewSouth HR themselves.

Possible advantages to recording timesheets on NewSouth HR within the work unit:
- Time schedule is far less rigid allowing the casual staff member more time to complete and submit a claim for hours worked. If submitting forms, the Human Resources Department requires that forms be received by 5 PM on the Friday almost 2 weeks before the actual pay Thursday. However if timesheets are entered on NewSouth HR within the work unit, claims may be entered up to 5 PM on the Wednesday almost 1 week before pay Thursday.
- No need for Administrator to make a last minute dash to the Human Resources Department to physically submit the form.
- No need to make copies of timesheets as work unit retains hard copy.
- Casual staff member is not required to wait as long for payment for hours worked.

If after attending this training session, you are interested in gaining access to enter timesheets online for casual general staff on NewSouth HR please obtain the permission from your Head of School (or equivalent) and contact Margaret James in the HR Systems Unit [mjames@unsw.edu.au](mailto:mjames@unsw.edu.au) or telephone (9385) 1528.

When entering timesheets online for casual general staff always refer to the attached User Procedures:
- Enter a New Timesheet
- Maintain an Existing Timesheet
- Enter a New Timesheet with Account Override

For further assistance in entering Timesheets contact Jenny Atwell in the Salaries Unit on telephone (9385) 2759 or email: [j.atwell@unsw.edu.au](mailto:j.atwell@unsw.edu.au)